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Introduccíon 
 
 
¡Bienvenidos a Flame Painter! 
 
Flame Painter es una aplicación de pintura única que le permite crear fácilmente obras de arte 
originales, efectos de luz, diseños poco convencionales o fantásticos fondos con pincel de 
llama.  
 
Fue creado como un proyecto experimental en mi serie ‘Yo soy un artista’. La visión inicial era 
crear una aplicación en la que cualquier persona podría crear algo hermoso. Fue hecho tanto 
como una herramienta para los artistas, así como para las personas sin habilidades artísticas 
que quieren crear algo único.  
 
La falta de inspiración y motivación a menudo son las razones por las que las personas no son 
creativas, sin embargo, las herramientas que utilizamos pueden llegar a ser la inspiración para 
la creatividad. Creo que con las herramientas que te inspiran, todo el mundo puede ser artista.  
Por eso nació Flame Painter. 
 
Esta es la tercera versión de Flame Painter. Hay muchas nuevas características incluidas – 
“Flame Painter Connect” - un plug-in de Photoshop que funciona como un conexión directa 
entre Flame Painter y Photoshop, con la capacidad de utilizar lápiz sensible a la presión de 
Wacom tableta y la cámara deLeap Motion, una importación y exportación fluida de PSD con 
capasy SVG archivos vectoriales. El motor de multi-core, nuevo renderer para alta resolución y 
los modos de fusión de Photoshop que han hecho de este software una herramienta poderosa 
para crear obras de arte profesionales. 
 
Este manual describe las características de la aplicación y le dice lo que necesitas saber para 
obtener la pintura. Hay una serie de parámetrosdisponibles de pincel de llama, sólo 
experimente con diferentes ajustes de pincel y tal vez encontrará una manera creativa 
completamente nueva de la auto-expresión. 
 
¡Gracias por comprar Flame Painter! Espero que pase gran tiempo con la pintura! 
 

 
Peter Blaškovič  
creadorde Flame Painter 

  

 



Ventana de Interfaz de Usuario 
 
 

Tools Panel/Panel de Herramientas 
 

 
Brush/Pincel - Elige la herramienta Pincel 
Pen/Pluma – Elige la herramienta Pluma 
Eraser/Borrador - Elige la herramienta Borrador 
Fill/Relleno - Elige la herramienta Relleno 
Transform/Transformar - Mueva y cambie el tamaño 
de la capa seleccionada  
Edit Vector Layer/Editar Capa Vectorial - Editeel modo 
de la capa vectorial seleccionada 
 
Zoom Out/Alejar - Aleja la pintura (a un tamaño 
mínimo del 5%). 
Zoom In/Acercar- Acerca la pintura (a un tamaño 
máximo de 800%). 
Reset Zoom/Restablecer Zoom - Compruebe el valor 
de zoom aquí. Pulse el botón para restablecer el zoom 
al 100%. 
Undo/Deshacer - Deshace la última operación de 
pintura que ha realizado. 
Redo/Rehacer - Rehace la última operación de 
deshacer.  



Brush/Pincel 
 
Hay tres modos de pintura diferentes: 
 
Flame/Llama - El modo de pintura de llama clásico. 
Follow/Siga - La pincelada seguirá el ratón con mayor precision, unpincel a base de línea. 
Ribbon/Cinta - El modo de pintura cinta, la pincelada se extiende un poco más amplio. 
 
Blending/Fusión - El modo de fusión de color. Hay tres modos de fusión  
- Normal para la pintura ordinaria,  
- Lighten/Modo claro (modo aditivo) es por lo general para los efectos de luz y fondos 

oscuros y  
- Darken/Modo oscuro (modo sustractivo) de fondo más claro. 
Opacity/Opacidad - Opacidad del pincel (0 - 100) 
 
Flame/Llama, Follow/Siga y Ribbon/Cinta parámetros del pincel 
 
Estos son los parámetros de la Herramienta de Pincel para experimentar: 
 
Size/Tamaño - Tamaño delPincel–el número de puntos del pincel (1-300) 
Span/Ancho - Ancho del Pincel (0 - 10) 
Dist - Distancia entre lospuntos del pincel (1 - 20) - esta opción se puede establecer si las 
"Lines" están "On" 
Soft/Suave – Suavidad del Pincel (1 - 100) – efecto del pincel más global  
Speed/Velocidad - Velocidad del Pincel (1 - 100) – el tiempo de la reacción del pincel; cuanta 
más alta la velocidad, más preciso el pincel. 
Center/Centro - Fuerzas Globales (0 - 100) 
Focus/Foco - Fuerzas Locales (0 - 100) 
Chaos/Caos - El Parámetro Muy Caótico (0 - 100) - cómo caóticamente puntos del pincel 
oscilan alrededor del pincel 
Noise/Ruido - El Parámetro de Ruido Loco (0-100) – cuanto más alto el número, más ruidoso el 
pincel 
 
Todosparámetros están en la correlación mutua.Cada ajuste influye la forma del pincel 
definitivo. 
 
Fade/Fundido - Pincel de Fundido: Fade In/Out (0-10). Ajuste el tiempo de Fundido/Fade 
In/Out. 
 
Fill/Relleno| Lines/Líneas - Cambiar entre "Fill/Relleno" y el modo de "Lines/Líneas" 
 
Detail/Detalle - Pincel de Detalle (1-4). Ajuste la calidad del detalle de la pincelada. Utilícelo si 
quiere unapincelada detallada y suave, o si usted ha configurado un tamaño del lienzo más 
grande.  
Nota: Al establecer el parámetro más alto, la pintura puede reducir la velocidad por su 
intensivocalculo. 
 



Antialiasing (AA) - Cambie entre "Antialiasing Normal" y "SuperSmooth Antialiasing"  
Nota: Al establecer el parámetro en "SuperSmooth Antialiasing", la aplicación puede reducir la 
velocidad, porque es más intensivo de calcularque "Antialiasing Normal". 
Esta característica está disponible en la edición PRO. 
 
 
 

Pen/Pluma 
 
Ajuste los parámetros de la herramienta Pluma: 
 
Blending/Fusión - El modo de fusión de color. Hay tres 
modos de fusión  
- Normal para la pintura ordinaria,  
- Lighten/Modo claro (modo aditivo) es por lo general 
para los efectos de luz y fondos oscuros y  
- Darken/Modo oscuro (modo sustractivo) de fondo 
más claro. 
Size/Tamaño - Tamaño de la herramienta Pluma (1-
200)  
Hardness/Dureza - Dureza de la herramienta Pluma (0-
100)  
Step/Paso - Paso de la herramienta Pluma (0-100) 
Opacity/Opacidad - Opacidad de la herramienta Pluma 
(0-100) 
 

Use sólo con Color. Transiciones del gradiente no están disponibles en la herramienta Pluma. 
 
 
 
Eraser/Borrador 
 
Ajuste los parámetros de la herramienta Borrador: 
 
Size/Tamaño - Tamaño de la herramienta Borrador (1-
200)  
Hardness/Dureza - Dureza de la herramienta Borrador 
(0-100)  
Step/Paso - Paso de la herramienta Borrador (0-100) 
Opacity/Opacidad - Opacidad de la herramienta 
Borrador (0-100) 
 
 
 
 

 



Fill/Relleno 
 
La capa se puede llenar con la paletade "Color" o de 
"Gradiente". Si se elige el Gradiente, la capa se puede 
llenar verticalmenteo horizontalmente. 
 
Verticalmente|Horizontalmente - Cambie entre 
Relleno "Vertical" y "Horizontal". 
 
 
Transform Layer/Transformar Capa 
 
Mueva y escala la capa seleccionada. Haga clic en “OK“ 
para acceptar los cambios o Cancelar sidecide no 
hacerlo. 
Si desea transformer y editar la Capa Vectorial 
(disponible en la edicion Pro), presione el boton “Edit 
Vector Layers“/“Editar Capas Vectoriales“. 

 
Editar Capas Vectoriales - Pro edición 

 
Paint Tool/Herramienta de Pintura - Pintar una nueva 
pincelada. Puede pintar una pincelada en una capa 
vectorial. 
Edit Tool/Herramienta de Editar - Editar vértices 
claves (puntos amarillos) y modificar el vector creado. 
Haga clic en vértices (gris) para cambiar a vértices 
claves (amarillos). 
Group Edit Tool/Herramienta de Grupo Editar - Editar 
grupo de vértices claves (puntos amarillos). 

Add & Remove Tool/HerramientasdeAgregar y Quitar - Retire vértices editables desde la línea 
de llama (atajo: Ctrl en Windows/Cmd en Mac OS). 
Curve Transform/Curva de Transformación - Cambiar el tamaño, rotar y escalar una pincelada. 
Init Curve Transform/Curva Init de Transformación - Cambiar el tamaño, rotar y reescalar una 
curva inicial de pincelada. 

 
Capas vectoriales tienen una gran ventaja de edición adicional de las pinceladas pintadas.En la 
capa vectorial se puede pintar una pincelada que se puede, además, transformar y editar. 
Después de pintar una pincelada, se puede cambiar cualquier parámetro de pincel, modo de 
fusión, la opacidad, paletas del color y del gradiente o cambiar todo el pincel preestablecido 
para otro. Es el modo de edición muy flexible que si usted desea, además, puede equilibrar los 
parámetros para establecer la forma del major pincel. 
 
Nota: Por favor tenga en cuenta que después de crear una nueva pincelada en una capa 
vectorial, la anterior se borra.La creación de una nueva capa vectorial para cada pincelada 
editable se recomienda. 



Palette Panel/Panel de la Paleta 
 

Color/Color | Gradient/Gradiente - Seleccione si desea pintar o llenar la capa con un color o 
con la transición del gradiente. 
 

Color 
 
Elija su color del pincel aquí. 
 
H (Hue) - Matizdel Pincel (0 - 359) 
S (Saturation) - Saturación del Pincel (0 - 255) 
L (Luminance) - Luminancia del Pincel (0 - 255) 
 
Palette/Paleta - Seleccione el color del pincel 
(+) (-) - Añadir y eliminar colores de colores 
personalizados. 
 
Un solo click en la caja de color abre un selector de 
paleta. El color que se utiliza para pintar en el Lighten 
Mode/Modo claro oDarken Mode/Modo oscuropuede 
que no aparezca exactamente lo mismo que se ve en el 
"Color Brush/Color de Pincel".Esto es típico de la 
aplicación y elModo claro/oscuro. Si usted desea tener 
el color exacto, elija el Modo Normal. 
 
 
Gradient/Gradiente 
 
Elija y configure su transición del gradiente. 
Haga click en el botón del color que desea cambiar y 
seleccione el color de la paleta. Se puede 
activar/desactivar el color que desea utilizar en el 
gradiente. 
 
Rotate/Girar–Gire la transición del gradiente. 
Flip/Voltear–Voltee latransición del gradiente. 
H | S | L - Cambie elmatiz, la saturación y la 
luminosidad de todos los colores en gradiente. 
 

Set Gradient Length/Establecer Longitud de Gradiente 
- Seleccione si desea utilizar gradiente para un ancho o 
una longitud del pincel y ajuste la longitud del 
gradiente.(1-10). Cuanto más alto el número, más 
frecuentemente se cambian los colores del degradado. 

 
(+) (-)- Añadir y eliminar colores y gradientes a partir de las listas. 



Brushes Panel/Panel del Pincel 
 
 

Ventana delos pinceles preestablecidos, se puede abrir o guardar los ajustes del pincel aquí. 
 
Use Palette/Utilice la Paleta - Utilice la paleta 
guardada en elpincel 
Utilice el Modo de Fusión – Utilice el modo de fusión 
(normal, claro o oscuro), que está guardado en el 
pincel. 
 
Share Brush/Compartir Pincel - Cargue su pincel a la 
Galería de Pinceles online. Haga clic en “Yes” para 
confirmar. 
 
(+) (-) - Añadir y eliminar pinceles preestablecidos de la 
lista. 
 
Para añadir un nuevo pincel preestablecido, haga clic 
en "Add Brush/Añadir pincel" (+), pinte en el icono del 
pincel, escriba el nombre del pincel y haga clic en 
Save/Guardar.  
Un pincel nuevo aparecerá en el menu 
Brushes/Pinceles inmediatamente. 
 
 

Nota: Al guardar el pincel en el Modo "Oscuro", sólo el fondo blanco está disponible. Al guardar 
el pincel en el Modo "Claro", sólo el fondo negro está disponible. 
 
Se puede Drag&Drop/Arrastrar y soltar los nuevos pincelesde la página web directamente en 
la aplicación. Enlace a las pinceles gratis: 
http://www.escapemotions.com/products/flamepainter/brushes/index.php  

http://www.escapemotions.com/products/flamepainter/brushes/index.php


Layers Panel/Panel de Capas 
 

Utilice la ventana del Panel de Capas para editar y manipular con capas. 
 
Blending/Fusión– 22 modos de fusión de Photoshop: 
Normal, Darken, Multiply, Color Burn, Linear Burn, 
Lighten, Screen, Color Dodge, Linear Dodge, Overlay, 
Soft Light, Hard Light, Vivid Light, Linear Light, Pin Light, 
Hard Mix, Difference, Exclusion, Hue, Saturation, Color, 
Luminosity y Subtract mode. 
Opacity/Opacidad – Ajuste la opacidad de la capa. (0-
100) 
Eye/Ojo - Muestre u oculte la capa activa (al lado del 
icono de la capa). 
Clean Layer/Limpiar Capa – Limpie el contenido de la 
capa 
Export to PS/Exportar a PS – Exporte la capa 
seleccionada a Photoshop. Puede obtener más 
informaciónes sobre Flame Painter Connect – el plug-in 
del Photoshop más adelante en este manual. 

    Esta característica está disponible en la edición PRO. 
 
New Layer/Nueva Capa - Añadir una nueva capa.  
New Vector Layer/Nueva Capa Vectorial - Añadauna nueva capa vectorial editable. 
Esta característica está disponible en la edición PRO. 
Duplicate Layer/Duplicar Capa - Duplique capa o capas activas.  
Merge Layers/Fusionar Capas - Fusione más capas enuna capa.  
Remove Layer/EliminarCapa - Elimine la capa o más capas activas. 
 
Se puede cambiar el nombre de una capa activa con un doble clic sobre ella en una Lista de 
Capas. 
La capa vectorial se puede convertir aMapa de bitsen el menú. 
 
Paneles de Paleta, de Pinceles y Capas son acoplables - es posible modificar, cambiar de 
posición y ajustar del ancho de los paneles.  



The Menu Bar/Barra de Menu 
 
File/Archivo - Contiene acciones relacionadas con cargar, guardar, exportar y publicar sus 
pinturas. 
Edit/Editar - Contiene artículos relacionados con la edición del proceso de pintura y el lienzo. 
Layers/Capas - Contiene acciones relacionadas con las capas. 
Filter/Filtro - Contiene acciones relacionadas con los filtros de imágenes y effectos. 
View/Vista - Contiene acciones relacionadas con el viewport y la interfaz de usuario. 
Window/Ventana - Contiene acciones relacionadas con la interfaz de usuario. 
Help/Ayuda - Contiene acciones que permiten obtener ayuda de la aplicación, o buscar 
actualizaciones en la página web. 
 

 
File Menu/Menu de Archivo 

 
El Menu de Archivo contiene acciones relacionadas con su pintura de la siguiente manera: 
 
New/Nueva ... - Abreel cuadro de diálogo que le permite crear una nueva pintura con los 
nuevos ajustes.  
Open/Abrir ... - Abreelcuadro de diálogo que le permite cargar una imagen desde disco.  
Save/Guardar ... - Guarde su pintura. Si no ha guardado anteriormente, se le pedirá que 
introduzca el nombre.  
Save As/Guardar como ... - Guarde una copia de su pintura actual como una nueva. 
 
Import/Importar... - Abre una imagen a la nueva capa. La imagen se redimensionada 
automáticamente al tamaño real del lienzo, pero se puede mover y cambiar a cualquier 
tamaño. 
 
Export layer to SVG…/Exportar la capa a SVG... – Exporte la capa vectorial activa como 
polígonos a formato gráfico vectorial redimensionable (del inglés Scalable Vector Graphics). 
Establece el número de polígonos con deslizador Detalle de 1- 4.  
Esta característica está disponible en la edición PRO. 
 
Ejemplo: Si la capa vectorial se compone de 100 000 polígonos y Detalle se ajuste en 1, se 
rendera y guarda 100 000 polígonos. Si se ajuste en 2, se cuadruplica el número de polígonos, 
por lo que el número de polígonos será de 400 000. Si se ajuste en 3, el número será de1 600 
000.Si se ajsute en 4, el número de polígonos será de 6 400 000. 
 
Publish/Publicar ... - Publique su pintura en la Galería de Flame Painter. Introduzca el nombre 
de la pintura, opcionalmente escriba una descripción y etiquetas. 
Publish preferences…/Preferencias de publicar... - Un sub-menú contiene preferencias de la 
Galería. 
 
 
 
 



Preferences/Preferencias... –Ajuste preferencias de Safe Boundary, Wacom Tablet y Leap 
Motion 
- Safe Boundary–Se puede establecer el lienzo extendido con más espacio visible que el 
tamaño del lienzo. Active y desactive una visibilidad y estableceunTamaño (Size) y la Opacidad 
(Opacity) de Safe Boundary. 
- Wacom Tablet - Ajustes para trabajar con tabletas que soportan sensibilidad a la presión del 
lápiz. Puede ajustar la intensidad de los parámetros que deben ser influenciadas por la presión 
del lápiz.  
- Leap Motion - Ajustes para el controlador deLeap Motion. Permite pintar con el control de 
movimiento de una mano. Seleccione tecla Shift para pintar con un dedo y utilice tecla "Shift" 
como un botón del ratón, o seleccione Show Two Fingers/Mostrar Dos Dedos para pintar con 
dos dedos. 
 
Quit/Quitar - Cierra la aplicación. (Sólo en Windows) 
 
Para obtener más información sobre cómo crear, cargar y guardar sus pinturas, consulte la 
"Creación, Carga y Guardar de Pinturas" sección más adelante en el manual. 
 

 
Edit Menu/Menu de Editar 

 
Undo/Deshacer - Deshace la última operación de pintura que ha realizado. Número de pasos 
para deshacer depende de la memoria de su computadora.Número máximo de estos pasos es 
de 100. 
Redo/Rehacer - Rehace la última operación de deshacer. 
 
Image Size.../Tamaño de Imagen... - Un sub-menú contiene Ancho, Alto de imagen 
redimensionada en píxeles y Safe Boundary en porcentaje. 
Ejemplo: si crea una imagen con tamaño 1200 x 1200 píxeles y Safe boundary se ajuste en 10%, 
el tamaño deSafe boundary es 120 píxeles.  
 
Compruebe Keep Aspect Ratio/Mantener relación de aspecto, si desea redimenzionar la 
imagen con la misma relación de aspecto que la imagen actual.  
 
Ejemplo: Si el ancho actual de la imagen es de 1200 píxeles y elalto es de 800 píxeles y desea 
redimenzionar del ancho de la imagen a 2400 píxeles con la misma relación de aspecto, 
activarKeep Aspect Ratio y la aplicación calculará la dimensión restante - 2400 x 1600 píxeles. 
 
Nota: Por favor, asegúrese de guardar su imagen antes de cambiar el tamaño de la imagen. 
Undo/Deshacer después elcambiodel tamaño no está disponible. 
 
Copy/Copiar - Copie la capa hacia o desde cualquier aplicación de terceros que soporta la 
imagen con canal alfa en el clipboard.  
Paste/Pegar - Pegue la capa hacia o desde cualquier aplicación de terceros que soporta la 
imagen con canal alfa en el clipboard. 
 
 



Herramientas siguientes trabajan solamente con las capas vectoriales, de lo contrario estas 
opciones aparecen en gris.  
Estas características están disponibles en edición Pro. 
 
Paint Tool/Herramienta de Pintura - Pinte una nueva pincelada. Se puede pintar una 
pincelada en una capa vectorial. 
Edit Tool/Herramienta de Editar - Edite vértices claves (puntos amarillos) y modifique el vector 
creado. Haga clic en vértices (grises) para cambiar a vértices clave (amarillos). 
Group Edit Tool/Herramienta de Grupo Editar - Edite grupo de vértices claves (puntos 
amarillos). 
Add & Remove Tool/HerramientasdeAgregar y Quitar - Retire vértices editables desde la línea 
de llama(atajo: Ctrl en Windows/Cmd en Mac OS). 
Curve Transform/Curva de Transformación - Cambie el tamaño, rote y escale una pincelada. 
Init Curve Transform/Curva Init de Transformación - Cambie el tamaño, rote y reescale una 
curva inicial de pincelada. 
 
 

Layer Menu/Menu de Capa 
 
New Layer/Nueva Capa– Añada una nueva capa.  
New Vector Layer/Nueva Capa Vectorial - Añada una nueva capa vectorial(disponible en 
edición Pro). 
Duplicate Layers/Duplicar Capa - Duplica capa o capas activas.  
Merge Layers/Fusionar Capas – Fusione capas en una sola capa.  
Delete Layers/Eliminar Capa - Elimine capa o capas activas. 
 
ShowLayer/Mostrar Capa- Muestre u oculte la capa activa.  
Transform Layer/Transformar Capa – Mueve y escale la capa activa. 
Clear Layer/Limpiar Capa - Limpia la capa.  
 
Export to Photoshop/Exportar a Photoshop - Exporte la capa con ajustes de la capa, con el 
fusion y la opacidad desde Flame Painter a Photoshop.  
Se puede encontrar más información sobre Flame Painter Connect - el Photoshop Plug-in más 
adelante en estemanual. 
 
Convert to Bitmap/Convertir a la Mapa de bits - Convertela capa vectorial a la capa de Mapa 
de bits.Esta característica está disponible en edición Pro. 
 
HiRes render... - Ajuste el detalle de High Resolution Renderer (1-5). Utilice al pintar en capas 
vectoriales.HiRes Renderer es unrenderer poligonal. Llena el espacio entre los puntos y hace la 
imagen más suave y sin la aparición de artefactos de Moire. 
Pulse la tecla Esc para cancelar la renderizacion. Por favor, espere hasta que el proceso se 
detiene. 
Esta característica está disponible en edición Pro. 
 
Nota: HiRes renderer está muy intensivo para cálcular y puede renderizar una capa vectorial 
incluso unas horas.  



Ejemplo: Si la capa vectorial se compone de 100 000 polígonos y Detalle de HiRes Renderer se 
ajuste en 1, se puede renderizar 1 minuto. Si se ajuste en 2, se cuadruplica el número de 
polígonos, por lo que el número de polígonos será de 400 000 y va a renderizar 4 minutos. Si se 
ajuste en 3, el número será de 1 600 000 y el tiempo será de 16 minutos. Si se ajuste en 4, el 
número será de 6 400 000 y el tiempo será 64 minutos. Si se ajuste a 5, el número será de 25 
600 000 y el tiempo será 256 minutos, circa 4 horas. 

 
 

Filter Menu/Menu de Filtro 
 
Blur/Desenfoque - Establecer radio de desenfoque de una ventana emergente.  

- Vista Preliminar - Mostrar u ocultar el resultado en tiempo real. 
Glow/Brillo- Establecer radio y fuerza de brillo de una ventana emergente.  

- Vista Preliminar - Mostrar u ocultar el resultado en tiempo real. 
 
Tile Layer/Capa de Azulejos – Crear una capa de azulejos horizontalmente y verticalmente. 
 

 
View Menu/Menu de Vista 

 
Zoom In/Acercar - Acerca la pintura (a tamaño máximo de 800%).  
Zoom Out/Alejar - Alejala pintura (a un mínimo del 5%).  
Zoom 100%/Acercar 100% - Comprueba el valor de zoom. Pulse el botón para reiniciar el zoom 
al 100%. 
 
Show Cursor/Mostrar el Cursor - Muestre u oculteel cursor. 
Show Brush Dots/Mostrar Puntos de Pincel - Muestre u oculte puntos del pincel. 
 
 

Window Menu/Menu de Ventana 
 
Tools/Herramientas – Muestre u oculte el Panel de Herramientas 
Palette/Paleta - Muestre u oculte el Panel de Paleta 
Brushes/Pinceles - Muestre u oculte el Panel de Pinceles 
Layers/Capas - Muestre u oculte el Panel de Capas 
 
Stay on Top/Permanecer arriba - Aplicación permanecerá siempre en la parte superior de 
otras aplicaciones.  
Fullscreen/Pantalla Completa - Cambie la ventana de la aplicación en modo de pantalla 
completa. (Presione Esc para salir). 
Show Main Menu/Mostrar Menu Principal - Muestre u oculte el Menu Principal(Presione Esc 
para salir).(Sólo en Windows, Menu Principal oculte automáticamente en Mac OS). 
 

 
 
 



Help Menu/Menu de Ayuda 
 
Help/Ayuda - Abrir este documento.  
Send Feedback/Enviar Comentarios... - Envíenos sus comentarios si usted tiene cualquier 
problema, una idea o simplemente le gusta el programa. Introduzca su correo electrónico y 
mensaje. 
Flame Painter Website/Página web de Flame Painter - Enlace a la página web: 
flame.escapemotions.com 
About Flame Painter/Sobre Flame Painter - Obtener un poco de información básica sobre 
Flame Painter, copyright y créditos. 
 
Show Brushes Folder/Mostrar la Carpeta dePinceles ... - Mostrar carpeta donde se guardan los 
pinceles. 
Online Brush Library/Biblioteca online de Pinceles ... - Mostrar biblioteca con pinceles 
descargables. 
 
Check for updates.../Buscar actualizaciones... - Este botón es visible cuando hay nuevas 
actualizaciones disponibles. 
Upgrade to Pro edition/Upgrade a la edición Pro - Haga clic si desea actualizar de Personal a la 
edición Professional. Disponible en la edición Personal.  



Flame Painter Connect 
 
Flame Painter Connect es plug-in para Photoshop CS5, CS5.5, CS6 y Photoshop CC. Es un canal 
de comunicación directo entre Photoshop y Flame Painter 3 Pro para el intercambio de las 
capas. 
 

Instalación 
 
Su paquete de instalación contiene de tres carpetas: 
 
Mac OS 
Windows 
Photoshop plugin 
 
Instalación para Photoshop CS5 y CS5.5  
 
Copie el archivo "Flame_Painter_Connect_1.2.swf"desde la carpeta“Photoshop plug-in” a la 
carpeta de instalación de Photoshop:  
 
- Windows 32bit:C:\Program Files (x86)\Adobe\Adobe Photoshop CS5\Plug-ins\Panels\ 
- Windows 64bit:C:\Program Files\Adobe\Adobe Photoshop CS5 (64 Bit)\Plug-ins\Panels\ 
- Mac OS:/Applications/Adobe Photoshop CS5/Plug-ins/Panels/ 
 
Instalación para Photoshop CS6 y CC  
 
PASO 1: Abra la carpeta "Photoshop_plugin" y haga doble clic sobre incluido archivo 
"Flame_Painter_Connect_1.2.zxp". Si el archivo no está asociado con Extension Manager 
automáticamente, abra suExtension Managery seleccione desde el menú: File  Install 
Extension (Archivo  Instalar Extensión). 
 
PASO 2:La ventana de Extension Disclaimer se abre - haga clic en “Accept“/"Aceptar".  
 
PASO 3:Se abre una ventana que dice que“a publisher cannot be verified“ (el publicador no 
puede ser verificado) - haga clic en “Install“/"Instalar".  
 
PASO 4: En caso de tener más productos de Adobe y las extensiones instaladas en su 
ordenador, una nueva ventana se puede abrir que requiere que usted elija la versión de 
Photoshop para que desea instalar un plug-in.  
 
Si Extension Manager no está instalado en el sistema, o plug-in de instalación no es válido, 
copie manualmente el archivo de "Flame_Painter_Connect_1.2.zxp"a la carpeta de instalación 
de Photoshop: 
 
- Windows 32bit:C:\Program Files (x86)\Adobe\Adobe Photoshop CS6\Plug-ins\Panels\ 
- Windows 64bit:C:\Program Files\Adobe\Adobe Photoshop CS6 (64 Bit)\Plug-ins\Panels\ 
- Mac OS:/Applications/Adobe Photoshop CS6/Plug-ins/Panels/ 



Cómo iniciar Flame Painter Connect 
 

 
PASO 1: Inicie ambos Photoshop y Flame Painter 3 Pro 
 
PASO 2: En Photoshop, cree un document nuevo 
desde el menu: File/Archivo New/Nuevo... 
 
PASO 3: En Photoshop haga clic en el menú:  
Window -> Extensions -> Flame Painter Connect.El 
nuevo panelo de Flame Painter Connect aparece en la 
parte derecha de la pantalla. 
 
 
 
 
 

 
Cómo intercambiar capas 

 
Exportación de Photoshop a Flame Painter 
 
Seleccione una capa en Photoshop que desea exportar a Flame Painter y haga clic en el botón 
"PS to FP". Si selecciona una capa vacía en Flame Painter, una capa de Photoshop se exportará 
a esta capa vacía. De lo contrario, se creará una nueva capa. 
 
 
Exportación de Flame Painter a Photoshop 
 
Seleccione una capa que desea exportar a Photoshop y haga clic en el boton “PS“ en el panel 
de Capas, o desde menú: Layer -> Export to Photoshop (atajo: Ctrl-F para Windows, Cmd-F 
para Mac OS). Si selecciona una capa vacía en Photoshop, una capa de Flame Painter se 
exportará a esta capa vacía, de lo contrario, se creará una nueva capa.  
 
Capas exportadas mantienen su nombre original y opacidad. La mayoría de los modos de fusión 
copia también sus ajustes preestablicidos originales.  



Creación, Carga y Guardar de Pinturas 
 

Creación de una nueva pintura 
 
Para crear una nueva pintura, seleccione la opción New/Nuevo... en el File Menu/Menu de 
Archivo. Al hacer esto, aparecerá el panel de Archivonuevo. Este panel le permite ajustar el 
tamaño de la nueva pintura, y configurar los ajustes del lienzo que va a pintar. También se 
puede cambiar el tamaño durante su pintura. En sección "Picture Size Info”/Info de Tamaño de 
Imagen " puede comprobar el tamaño de impresión de la imagen. 
 
Color Button/Botón de Color le permite seleccionar el color del fondo o la elección del fondo 
Black/Negro o White/Blanco preestablecido. 
 
Por último, haga clic en OK para crear una nueva pintura, o Cancel/Cancelar, si no lo desea. 
 
 

La Apertura de una Pintura 
 
Para abrir una pintura, seleccione la opciónOpen/Abrir...en el Menu de Archivo.Este panel le 
permite abrir una imagen o ilustracion previamente guardada y ajustar las características. 
 
Por último, haga clic en OK para abrir lapintura, o Cancel/Cancelar,si no lo desea. 
 
También puede Drag and Drop/Arrastrar y Soltarimágenes directamente desde cualquier 
fuente - carpeta, navegador o página web yse abre como una nueva capa. 
 

 
Guardar una pintura 

 
Para guardar la pintura, utilice la opción Save/Guardar... en el Menu de Archivo.El formato por 
defecto es FPA formato de archivo, que contiene toda la información acerca de la pintura y las 
capas. Utilice esteformato si desea continuar con la pintura posterior.  
 
En Flame Painter 3 Pro se puedeabrir y guardar PSD archivos con capas para Photoshop, Gimp 
u otros programas de mapa de bits quesoportan formato de archivo PSD - con todas las 
configuraciones de capas, modos de fusión y opacidad. Es posible exportar las capas vectoriales 
comoun archivo en formato SVG para Illustrator u otros editores de gráficos vectoriales, donde 
se puede continuamente editar la forma su flame imagenes en los vectores. 
 
También puede elegir otros formatos de archivo, pero éstos no contienen toda la información 
sobre la pintura y no se puede abrir correctamente (el color del fondo puede ser diferente, o la 
transparencia puede no haberse guardado en formato JPG). 
Si desea guardar la pintura con la configuración específica o de forma que pueda ser leído por 
otras aplicaciones, utilice laopciónSave As/Guardar como... del Menu de Archivo. Le permite 
guardar la pintura en formato PSD, PNG, TIF, BMP o JPG. 
Por último, haga clic en OK para guardar la pintura o Cancel/Cancelarsi no lo desea. 



Publicar una pintura a la Galería 
 

 
Crear una Cuenta de Galería 

 
Para publicar sus pinturas, en primer lugar hay que crear una cuenta. Para crear una cuenta, 
tiene dos opciones: 
 
De aplicación: 
Crea tu Cuenta de Galería desdeel Menu de Flame Painter: Archivo-> Preferencias de Publicar 
(File->Publish Preferences).Elija Su Nombre, Correo Electrónico ("Su ID") y la Contraseña para la 
galería y, opcionalmente el enlace a su Página Web. 
 
De web: 
En Página web de la Galería deFlame Painterhaga click Inicio de sesión -> Crear cuenta (login -> 
Create Account) e introduzca "Su ID" (correo electrónico de su registracion). 
Le enviaremos una Contraseña, que se puede cambiar más adelante. 
Nota: Puede encontrar "Su ID" en el menú de Flame Painter Ayuda-> Acerca del Flame Painter 
(Help->About Flame Painter). 
Si "Tu ID" no existe, introduzca su dirección de correo electrónico activo. 
 

 
Publicar pinturas del Flame Painter a la Galleria 

 
Para publicar su pintura, utilice la Publish/Publicar... opción en el Menu de Archivo. Introduzca 
el Nombre de la Pintura, un Descripción y Etiquetas de Pintura. Haga clic en el botón 
Publish/Publicar. Tu foto será publicada en la pagina web de laGaleria del Flame Painter 
(www.escapemotions.com/gallery), donde puede editar las imágenes más tarde. 
 
      

Editar tu perfil y Pinturas en la Galería 
 
Si ya ha creado una cuenta, vaya al sitio web de Gallery, pulse Login/Iniciar 
sesióneintroduzca"Su ID" y la Contraseña/Password.  
En la sección Edit Pictures/Editar imágenes se puede editar el nombre de las pinturas, 
descripción, etiquetas y otros ajustes. 
En la sección My profile/Mi perfil puede cambiar su Contraseña.  

http://www.escapemotions.com/gallery


Atajos de teclado 
 
        Windows   Mac OS 
New/Nuevo...       Ctrl-N    Cmd-N 
Open/Abrir...       Ctrl-O    Cmd-O 
Save/Guardar      Ctrl-S    Cmd-S 
Save As/Guardar Como...      Ctrl -Shift-S   Cmd-Shift-S 
Import/Importar       Ctrl-Shift-O  Cmd-Shift-O 
Publish/Publicar...       Ctrl -P    Cmd-P 
Quit/Quitar       Ctrl -Q   Cmd-Q 
 
Undo/Deshacer      Ctrl -Z    Cmd-Z 
Redo/Rehacer      Ctrl -Shift-Z   Cmd-Shift-Z 
Copy/Copiar        Ctrl-C        Cmd-C 
Paste/Pegar        Ctrl-V        Cmd-V 
Export to Photoshop/Exportar a PS     Ctrl-F   Cmd-F 
 
Brush/ Pincel      Q    Q 
Pen/Pluma       A    A 
Eraser/Borrador      E    E 
Fill/Relleno       F    F 
Transform/Transformar       T        T 
Edit Vector Layer/Editar Capa Vectorial     V        V 
 
Increase Value +1/Aumentar el Valor +1  Up    Up 
Decrease Value -1/ Disminuir el Valor -1  Down    Down 
Increase Value +10/ Aumentar el Valor +10  Pg Up    Pg Up 
Decrease Value -10/ Disminuirel Valor -10  Pg Down   Pg Down 
Clean Layer/Limpiar la Capa    Del    Del 
 
Move a Canvas/Mover Lienzo     Botón derecho del ratón o  
         Escpaciador + LMB 
 
Zoom In/Acercar       Ctrl - +   Cmd - + 
Zoom Out /Alejar      Ctrl - -    Cmd - - 
Zoom 100%/Acercar 100%    Ctrl – 0   Cmd - 0 
Zoom In | Out/Acercar | Alejar     Desplazamiento 
 
Safe Boundary      Ctrl-B    Cmd-B 
Cursor Show|Hide/Mostrar|Ocultar Cursor  Alt-C    Alt-C 
Brush Dots Show|Hide/ Mostrar|Ocultar 
Puntos de Pincel      Alt-D    Alt-D 
 
Fullscreen/Pantalla completa    Ctrl –L   Cmd - L 
Show Main Menu/Mostrar Menu Principal  Ctrl – M   Cmd - M 
Help/Ayuda       F1    Cmd + ? 
 
 
 
 



Paint Tool/Herramienta de Pintura   1    1 
Edit Tool/ Herramienta de Editar   2     2 
Group Edit Tool/Herram.de Grupo Editar  3    3 
Add & Remove Tool/ Agregar y Quitar  4    4 
Curve Transform/ Curva de Transformación  5     5 
Init Curve Transform/ Curva  
de Transformación Init     6    6 
 
 
 
 
 

Versión Personal contra Versión Profesional 
 
 
Versión personal es más adecuada para los usuarios que quieren tener una herramienta 
creativa completa, pero no necesitanusarlas funciones avanzadas y novenden las imágenes 
creadas o modificadas en Flame Painter. La licencia permite instalar Flame Painter en varios 
ordenadores para solo usuario para el uso personal y no comercial o para actividades sin fines 
de lucro. 
 
Versión profesional es mejor para los profesionales y los usuarios que necesitan funciones 
avanzadas como Capas Vectoriales o conexión con Photoshop. La licencia permite la instalación 
de Flame Painter en un ordenador para las empresas; o en varios ordenadores paraun usuario 
único. Esta licencia permite la utilización del software para el uso comercial o actividades de 
beneficio, así como para las actividades no comerciales. 
 
Para más detalles, lea el Acuerdo de Licencia de Software completo. 
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Flame Painter Connect © 2014 Escape Motions, s.r.o 
 
Flame Painter Equipo: 
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Flame Painter End-User Software License Agreement 
 
 
Copyright 2012-2014 Escape Motions, s.r.o. All Rights Reserved. 
Copyright 2009-2012 Peter Blaškovič. All Rights Reserved. 
 
This license is a legal agreement between you and Escape Motions for the use of Flame Painter 
software (the "Software"). By downloading, installing, copying, or otherwise using the 
Software, you acknowledge that you have read terms and conditions of this license, 
understand them, and agree to be bound by them. If you do not agree with these terms and 
conditions, Escape Motions is unwilling to license the Software to you, and you are not 
authorized and may not use the Software. 
 
 
Permitted Use 
 
Flame Painter Personal: 
 
Users of the Flame Painter may use the Software for personal, non-commercial, or non-profit 
activities. 
You may install the Software on multiple computers provided that not more than one of those 
computers is in use simultaneously and that those computers are solely for your own personal 
use. 
 
Flame Painter Professional: 
 
Users of the Flame Painter may use the Software for commercial, or for-profit activities as well 
as for personal, non-commercial, or non-profit activities. 
The Software may be installed on a computer that is for multiple users but it may not be 
installed on more than one computer regardless of whether those computers are operated 
simultaneously or not. 
You may install the Software on multiple computers provided that not more than one of those 
computers is in use simultaneously and that those computers are solely for your own personal 
use. 
 
You may not remove the copyrights notices from the Software. You may make one (1) copy of 
the Software for back-up or archival purposes. 
 
 
Restrictions 
 
This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law 
and international treaty. This is a license, not a transfer of title, and unless you have been 
granted prior, written consent from Escape Motions you may not: 
a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party. 
b, Sell, rent, lease, assign, or sublet the Software or portions thereof. 



c, Grant rights to any other person. 
d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on the 
Software or the documentation in whole or in part. 
e, Use the Software in violation of any international law or regulation. 
 
You must not intentionally or unintentionally make the Software available on any web server, 
ftp server, file sharing network, shared directory, or other location where any other person can 
acquire a copy of the Software. You are responsible for keeping the Software safe from being 
copied by others. 
 
 
Display of Copyright Notices 
 
All copyright and proprietary notices and logos within the Software files must remain intact. 
 
 
Indemnity 
 
You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions or 
suits, as well as any related expenses, liabilities, damages, settlements or fees arising from your 
use or misuse of the Software, or a violation of any terms of this license. 
 
The Software may contain technical inaccuracies or typographical errors, so changes and/or 
updates may be affected without notice. 
Peter Blaskovic may also make improvements and/or other changes to the Software at any 
time without notice. 
 
 
Disclaimer Of Warranty 
 
THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR 
IMPLIED, AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO, 
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE. FURTHER, PETER BLASKOVIC DOES NOT WARRANT THAT 
THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE. 
 
 
Limitations Of Liability 
 
YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE. IN 
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE FOR 
CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION WITH 
THE SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE 
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING BUT 
NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST 
PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR 
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS. 


